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Appendix K, “Administrative Users and Groups in OES,” on page 271

Appendix L, “Coordinating Password Policies Among Multiple File Services,” on page 273
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+ Appendix M, “Configuration and Log Files,” on page 281
+ Appendix N, “Small Footprint CIM Broker (SFCB),” on page 297

Purpose

This guide provides:

+ Planning and implementation instructions
+ Service overviews

+ Links to detailed information in other service-specific guides.
Audience

This guide is designed to help network administrators

+ Understand Open Enterprise Server services prior to installing them.
+ Make pre-installation planning decisions.
+ Understand installation options for each platform.

+ Implement the services after they are installed.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with OES 2018 SP3. Please use the User Comments feature at the bottom of each page of
the online documentation.

Additional Documentation

Additional documentation is found on the OES 2018 SP3 Documentation Web site (https://
www.novell.com/documentation/open-enterprise-server-2018/).

Documentation Conventions

In this documentation, a greater-than symbol (>) is used to separate actions within a step and items
within a cross-reference path.

About This Guide
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Welcome to Open Enterprise Server 2018
SP3

Micro Focus Open Enterprise Server delivers all the enterprise-class networking, file, and print
services that enterprises have relied on for years. OES provides valuable benefits including power
savings, virtualization, manageability, and interoperability.

OES provides several new features that reduce administrative complexities and provide access to file
and storage services regardless of eDirectory as an identity source. For information about the new
features, see What’s New or Changed in OES 2018 SP3.

Beginning with OES 2018, the support for the add-on install is deprecated and OES is installed only
through integrated install media. For more information on OES integrated install procedure, see OES:
Installation and Upgrade Guide.
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2.1

2.1.1

Planning Your OES 2018 SP3
Implementation

As you plan which OES services to install, you probably have a number of questions. The following
sections are designed to help answer your questions and alert you to the steps you should follow for
a successful OES implementation.

+ Section 2.1, “Plan for eDirectory,” on page 17

+ Section 2.2, “Identify a Purpose for Each Server,” on page 18

*

Section 2.3, “Understand Server Requirements,” on page 18

*

Section 2.4, “Understand User Restrictions and Linux User Management,” on page 18

*

Section 2.5, “Understand Your Installation Options,” on page 19

Plan for eDirectory

eDirectory is the heart of OES network services and security.

+ Section 2.1.1, “Installing Into a New Tree,” on page 17

¢ Section 2.1.2, “Installing Into an Existing Tree,” on page 18

Installing Into a New Tree

If you are creating a new eDirectory tree on your network, you must do some additional planning
before you install the first server into the tree. The first server is important for two reasons:

+ You create the basic eDirectory tree structure during the first installation

+ The first server permanently hosts the Certificate Authority for your organization
To ensure that your eDirectory tree meets your needs, take time to plan the following:

+ Structure of the eDirectory tree: A well-designed tree provides containers for servers, users,
printers, etc. It is also optimized for efficient data transfer between geographically dispersed
locations. For more information, see “Designing Your NetlQ eDirectory Network” in the Net/Q
eDirectory Administration Guide.

+ Time synchronization: eDirectory requires that all servers, be time synchronized. For more
information, see Chapter 10.3, “Time Services,” on page 82.

+ Partitions and replicas: eDirectory allows the tree to be partitioned for scalability. Replicas
(copies) of the partitions provide fault tolerance within the tree. The first three servers installed
into an eDirectory tree automatically receive replicas of the tree’s root partition. You might
want to create additional partitions and replicas. For more information, see “Managing
Partitions and Replicas” in the Net/Q eDirectory Administration Guide.
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2.2

2.3

2.4

For information on these and other eDirectory planning tasks, see the Net/Q eDirectory
Administration Guide.

Installing Into an Existing Tree

When installing into an existing tree, make sure you observe the following best practices whenever
possible:

+ Use Existing eDirectory Objects: Whenever possible, existing eDirectory objects, organizational
units, users, groups, password policies, etc. should be used during the installation.

If new contexts or users are needed, it is best to create these prior to the installation.

+ Synchronize Replicas Before and After: Ensure that all eDirectory partitions affected by the
installation are synchronized before you begin and after you finish the installation.

Also, before installing into an existing tree, be sure you understand the information in
Section 12.2.3, “eDirectory Coexistence and Migration,” on page 129.

Identify a Purpose for Each Server

Large networks usually have one or more servers dedicated to providing a single network service.
For example, one or more servers might be designated to provide file services to network users
while other servers provide iPrint printing services for the same users.

For smaller organizations, it is often not practical or cost effective to dedicate servers to providing a
single service. For example, the same server might provide both file and print services to network
users.

Prior to installing a new server on your network, you should identify the service or services that it
will provide and see how it will integrate into your overall network service infrastructure.

Understand Server Requirements

OES has specific hardware and software requirements.

Prior to installing OES, make sure your server machine and network environment meet the
requirements outlined in the following sections:

+ OES 2018 SP3 Server (Physical): “Preparing to Install OES 2018 SP3” in the OES 2018 SP3:
Installation Guide.

+ OES 2018 SP3 Server (Virtual): “System Requirements” in the OES 2018 SP3: Installation Guide.

Understand User Restrictions and Linux User
Management
If you plan to use Linux User Management, be sure you understand the security implications before

you accept the default PAM-enabled service settings. The implications are explained in
Section 19.2.2, “User Restrictions: Some OES Limitations,” on page 209.
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2.5

2.5.1

Understand Your Installation Options

Before installing OES, you should be aware of the information in the following sections:

+ Section 2.5.1, “OES Installation Overview,” on page 19
+ Section 2.5.2, “About Your Installation Options,” on page 20
+ Section 2.5.3, “Use Predefined Server Types (Patterns) When Possible,” on page 21

OES Installation Overview

The software and network preparation processes required to install OES are outlined in Figure 2-1.

NOTE: Chapter 3, “Getting and Preparing OES Software,” on page 23 contains instructions for
obtaining the I1SO image files referred to in the following illustration.
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Figure 2-1 OES Install Preparation
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Installation Guide.
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For information about preparing the tree, see “OES eDirectory Rights Needed for Installing OES” and
“Preparing eDirectory for OES 2018 SP3” in the OES 2018 SP3: Installation Guide.

2.5.2 About Your Installation Options

As illustrated in the previous section, OES lets you install from either physical media or from files on
the network.

+ “OES 2018 SP3 Options” on page 21

+ “Virtual Machine Installation Options” on page 21
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2.5.3

OES 2018 SP3 Options

OES includes numerous installation options as documented in the OES 2018 SP3: Installation Guide.

+ OES Install Media: You can install OES from a single ISO or DVD obtained from a Micro Focus
Authorized Reseller or created from a downloaded ISO image file.

See “Preparing Physical Media for a New Server Installation or an Upgrade ” in the OES 2018
SP3: Installation Guide.

+ DVD Install: You can install OES by using a DVD obtained from a Micro Focus Authorized Reseller
or created from downloaded I1SO image files.

See “Preparing Physical Media for a New Server Installation or an Upgrade ” in the OES 2018
SP3: Installation Guide.

+ Network Install: You can install from the network by using the NFS, FTP, or HTTP protocol.
See “Setting Up a Network Installation Source” in the OES 2018 SP3: Installation Guide.
+ Automated Install: You can install from the network by using an AutoYaST file.

This lets you install without providing input during the installation process. It is especially useful
for installing multiple servers with similar configurations.

See “Using AutoYaST to Install and Configure Multiple OES Servers” in the OES 2018 SP3:
Installation Guide.

Virtual Machine Installation Options

Virtual machine installations offer additional options. For more information, see “Installing,
Upgrading, or Updating OES on a VM” in the OES 2018 SP3: Installation Guide.

Use Predefined Server Types (Patterns) When Possible

OES includes predefined server installation options that install only the components required to
provide a specific set of network services. These server types are called patterns.

For example, if you want to install an OES server that provides enterprise level print services, you
should select the OES iPrint pattern during the installation.

You should always choose a predefined server type if one fits the intended purpose of your server. If
not, you can choose to install a customized OES server with only the service components you need.

More information about server patterns is available in “OES Services Pattern Descriptions” in the
OES 2018 SP3: Installation Guide.
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3.1

3.2

Getting and Preparing OES Software

This section contains instructions for getting and preparing Open Enterprise Server software and
discusses the following topics:

+ Section 3.1, “64-Bit Only,” on page 23

+ Section 3.2, “Do You Want to Purchase OES 2018 SP3 or Evaluate It?,” on page 23

+ Section 3.3, “Evaluating OES 2018 SP3 Software,” on page 24

+ Section 3.4, “Downloading and Preparing OES Software,” on page 24

+ Section 3.5, “Licensing,” on page 26

If you have not already done so, we recommend that you review the information in Section 2.5,
“Understand Your Installation Options,” on page 19.

64-Bit Only

Compatibility is the first thing to consider as you start planning which software to download and
install.

OES is a set of services available in 64-bit only.

Do You Want to Purchase OES 2018 SP3 or Evaluate It?

If you want to evaluate OES prior to purchasing it, skip to the next section, Evaluating OES 2018 SP3
Software.

If you have decided to purchase OES, visit the Micro Focus Product Inquiry page (https://
www.microfocus.com/en-us/products/open-enterprise-server/contact).

When you purchase OES, you receive an activation code. This code is required for registering an OES
system in the Micro Focus Customer Center. After it is registered, your server can receive online
updates, including the latest support pack.

As part of the purchase process, it is important that you understand the OES licensing model. For a
brief description, see Section 3.5, “Licensing,” on page 26.

After completing your purchase, the installation process goes more smoothly if you understand your
installation options. If you haven’t already done so, be sure to review the information in Section 2.5,
“Understand Your Installation Options,” on page 19 and then skip to Chapter 4, “Installing OES,” on

page 27.
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3.3.2

3.3.3

3.4

Evaluating OES 2018 SP3 Software

This section walks you through the OES software evaluation process and discusses the following
topics:

+ Section 3.3.1, “Understanding OES Software Evaluation Basics,” on page 24

+ Section 3.3.2, “Evaluating OES,” on page 24

+ Section 3.3.3, “Installing OES for Evaluation Purposes,” on page 24

Understanding OES Software Evaluation Basics

You can evaluate the full OES product. The evaluation software is the complete, fully functional OES
product.

As you install each server, you are required to accept an end user license agreement (EULA). Your
rights to evaluate and use the OES product are limited to the rights set forth in the EULA.

Briefly, the evaluation period for OES servers is 60 days. To receive software updates during this
time, you must have or create an account with the Customer Center, receive evaluation code for OES
while downloading the software, and use this code to register your server. No software updates can
be downloaded after the 60-day evaluation period expires until you purchase the product.

Evaluating OES

During the evaluation period, we recommend that you fully explore the many services available in
OES.

Installing OES for Evaluation Purposes

After completing the instructions in Section 3.4.1, “Downloading OES Software from the Micro Focus
Web Site,” on page 25, you will have an activation/evaluation code for OES. As you install OES, you
should register with the Micro Focus Customer Center and use this code to enable your server for
online updates from the OES patch channels.

IMPORTANT: Always download the current patches during an installation.

Instructions for using the activation codes during an installation are found in “Specifying Customer
Center Configuration Settings” in the OES 2018 SP3: Installation Guide.

The evaluation period begins when the codes are issued. Use the same activation codes for each OES
server you install during the evaluation period.

Downloading and Preparing OES Software

+ Section 3.4.1, “Downloading OES Software from the Micro Focus Web Site,” on page 25
+ Section 3.4.2, “Preparing the Installation Media,” on page 25

+ Section 3.4.3, “Installing Purchased Activation Codes after the Evaluation Period Expires,” on
page 26
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3.4.1

3.4.2

Downloading OES Software from the Micro Focus Web Site

If you already have OES ISO image files, skip to Section 3.4.2, “Preparing the Installation Media,” on
page 25.

If you have OES product media, skip to Section 3.3.3, “Installing OES for Evaluation Purposes,” on
page 24.

To download ISO image files from the Web:
1 Login to Software Licenses and Downloads (SLD) (https://sld.microfocus.com/mysoftware/
index) website or if you don’t have a Micro Focus account, create an account.
2 Click Search Account and select your account.

3 Click Downloads and select the product as Open Enterprise Server 2018 SP3, product name
depending on your license type and version as 2018.3.

4 |n the Description column, mouseover Reference Material and click Readme to view the .iso
name and the new features in the release.

5 In the Action column, mouseover More Details to view the . iso name and checksum value.
6 Inthe Action column, click Download to download the . iso file.
7 If you have purchased OES previously and received your OES activation codes, skip to Step 9.

Otherwise, in the Evaluating Open Enterprise Server 2018 SP3 section, click the Get Activation
Codes link in the Open Enterprise Server 2018 SP3 paragraph.

60-day evaluation codes are sent in separate e-mail messages to the e-mail address associated
with your Micro Focus account.

8 Access your e-mail account and print the messages or write down the activation codes.
OES code is required for product registration and downloading software updates.

9 Verify the integrity of each downloaded file by running an MD5-based checksum utility on it and
comparing the values against the value displayed in Step 5.

For example, on a Linux system you can enter the following command:
sha256sum filename
where filename is the name of the . iso file you are verifying.

For a Windows system, you need to obtain a Windows-compatible MD5-based checksum utility
from the Web and follow its usage instructions.

10 (Optional) If you plan to install OES from files on your network, see the instructions in “Setting
Up a Network Installation Source” in the OES 2018 SP3: Installation Guide.

Preparing the Installation Media

IMPORTANT: If you have downloaded . iso image files from the Web, it is critical that you verify the
integrity of each file as explained in Step 9 on page 25. Failure to verify file integrity can result in
failed installations, especially in errors that report missing files.

Instructions for preparing installation media are located in “Setting Up a Network Installation
Source” in the OES 2018 SP3: Installation Guide.
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3.4.3

3.5

3.5.1

3.5.2

Installing Purchased Activation Codes after the Evaluation Period
Expires

After purchasing Open Enterprise Server, use the instructions in “Registering the Server in the
Customer Center Using the Command Line” in the OES 2018 SP3: Installation Guide to enter the
purchased activation codes that you received with your purchase. After logging in as root, complete
the step where you enter the activation codes, replacing the evaluation codes with the purchased
codes.

Licensing

This section explains the following:

¢ Section 3.5.1, “The OES Licensing Model,” on page 26
+ Section 3.5.2, “OES Doesn’t Support NLS,” on page 26

The OES Licensing Model

The only OES licensing restriction is the number of user connections allowed to use OES services on
your network. You are authorized to install as many OES servers as you need to provide OES services
to those users.

For example, if your OES license is for 100 user connections, you can install as many OES servers as
desired. Up to 100 users can then connect to and use the services provided by those OES servers.
When you install OES, you must accept an end user license agreement (EULA). Your rights to use the
OES product are limited to the rights set forth in the EULA.

For more information on OES licensing, see EULA (https://www.microfocus.com/media/
documentation/open-enterprise-server-2018-documentation.pdf).

OES Doesn’t Support NLS

Novell Licensing Services (NLS) are not available on OES, nor does an OES installation require a
license/key file pair (*.n1f and *.nfk). Therefore, in a mixed OES and NetWare eDirectory tree, at
least one NetWare server must hold a replica for each partition where there is a NetWare server
object.
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4.1

4.1.1

Installing OES

IMPORTANT: Before you install Open Enterprise Server, ensure to review the information in
Chapter 2, “Planning Your OES 2018 SP3 Implementation,” on page 17.

This section briefly covers the following:

+ Section 4.1, “Installing OES on Physical Servers,” on page 27
+ Section 4.2, “Installing OES Servers in a Xen VM,” on page 28
+ Section 4.3, “Installing OES Servers in a KVM Virtual Machine,” on page 28

Installing OES on Physical Servers

The OES installation leverages the SUSE Linux YaST graphical user interface.
To ensure a successful installation:

1. Read and follow all instructions in the OES 2018 SP3: Release Notes.

2. Carefully follow the instructions in the OES 2018 SP3: Installation Guide, especially those found
in

¢ “Preparing to Install OES 2018 SP3”
¢ “Installing OES 2018 SP3 as a New Installation”

3. Make sure you always download the latest patches as part of the Customer Center configuration
during the install. This ensures the most stable configuration and installation process and
prevents some issues that are documented in the product Readme.

4. After updating the server, you are prompted for the root password.

This happens because the server reboots as part of the update process and the root password
is no longer in memory.

5. During the installation, you have the option to disable each service for later configuration.
However, we recommend that you configure all services at install time simply because the
process is more streamlined.

For more information on configuring services later, see “Installing or Configuring OES Services
on an Existing OES 2018 SP3 Server” in the OES 2018 SP3: Installation Guide.

What's Next

The various service sections in this guide contain information about completing your OES services
implementation. See the sections for the services you have installed, beginning with Chapter 9,
“Managing OES,” on page 71.
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4.2 Installing OES Servers in a Xen VM

Installing OES servers on a Xen virtual machine involves installing an OES or SUSE Linux Enterprise
Server (SLES) 12 SP5 VM host server, creating a VM, and then installing an OES server in the VM.

To get started with Xen virtualization in OES, see the following:

¢ “Introduction to Xen Virtualization (https://documentation.suse.com/sles/12-SP5/html/SLES-
all/cha-xen-basics.html)” in the Virtualization Guide (https://documentation.suse.com/sles/12-

SP5/html/SLES-all/book-virt.html).
+ “Installing, Upgrading, or Updating OES on a VM” in the OES 2018 SP3: Installation Guide.

4.3 Installing OES Servers in a KVM Virtual Machine

Installing OES servers on a KVM virtual machine involves installing an OES or SUSE Linux Enterprise
Server (SLES) 12 SP5 VM host server, creating a VM, and then installing an OES server in the VM.

To get started with KVM virtualization in OES, see the following:

¢ “Introduction to KVM Virtualization (https://documentation.suse.com/sles/12-SP5/html/SLES-
all/cha-kvme-intro.html)” in the Virtualization Guide (https://documentation.suse.com/sles/12-

SP5/html/SLES-all/book-virt.html).
+ “Installing, Upgrading, or Updating OES on a VM"” in the OES 2018 SP3: Installation Guide.
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5.1

Upgrading to OES

Open Enterprise Server (OES) provides the option of updating an existing system to the new version
without completely reinstalling it. No new installation is needed. Existing data such as home
directories and system configuration is kept intact. During the life cycle of the product, you can apply
Service Packs to increase system security and correct software defects.

This section provides information and links for upgrading to Open Enterprise Server.

+ Section 5.1, “Supported Upgrade Paths,” on page 29
+ Section 5.2, “Planning for the Upgrade to OES 2018 SP3,” on page 30
+ Section 5.3, “Meeting the Upgrade Requirements,” on page 30

Supported Upgrade Paths

Table 5-1 outlines the supported paths for upgrading to OES 2018 SP3.

Table 5-1 Supported OES 2018 SP3 Upgrade Paths

Source Patch Version Destination Upgrade Methods
Supported
OES 2018 SP2 (64-bit) Latest Patch OES 2018 SP3 (64-bit) AutoYaST

Physical media
Channel Upgrade

OES 2018 SP1 (64-bit) Latest Patch OES 2018 SP3 (64-bit) AutoYaST
Physical media

OES 2018 (64-bit) Latest Patch OES 2018 SP3 (64-bit) AutoYaST
Physical media
OES 2015 SP1 (64-bit) Latest Patch OES 2018 SP3 (64-bit) AutoYaST

Physical media

IMPORTANT: Source servers must have all patches applied from the appropriate SUSE Linux
Enterprise Server (SLES) and OES patch update repositories prior to an upgrade.

Other OES releases can be upgraded by installing the interim OES version. For example, to upgrade
from OES 2 SP3 to OES 2018 SP1, upgrade to OES 11 SP3 or OES 2015 SP1 first and then upgrade
from OES 11 SP3 or OES 2015 SP1 to OES 2018 SP2.
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5.2

5.2.1

5.2.2

5.3

5.3.1

Planning for the Upgrade to OES 2018 SP3

¢ Section 5.2.1, “Be Sure to Check the Release Notes,” on page 30
¢ Section 5.2.2, “Upgrading in Text Mode,” on page 30

Be Sure to Check the Release Notes

The OES 2018 SP3: Release Notes documents issues that Micro Focus plans to address in a future
release.

Upgrading in Text Mode

If you plan to upgrade your OES server to OES 2018 SP3 in text mode, before starting the upgrade
process, you must change the default runlevel to runlevel 3 in the/etc/inittab file. If you fail to
do this, you might not be able to continue the upgrade process and complete it at later stages.

Meeting the Upgrade Requirements

Meet the following requirements before you upgrade and install any OES components:

+ Section 5.3.1, “Securing Current Data,” on page 30

+ Section 5.3.2, “Ensuring That There Is Adequate Storage Space on the Root Partition,” on
page 31

+ Section 5.3.3, “Preparing the Server You Are Upgrading,” on page 31

+ Section 5.3.4, “Checking the Server’s DNS Name,” on page 31

¢ Section 5.3.5, “Ensuring That the Server Has a Server Certificate,” on page 32
+ Section 5.3.6, “Changing the Mount Options Before an Upgrade,” on page 32
¢ Section 5.3.7, “Preparing an Installation Source,” on page 33

¢ Section 5.3.8, “Synchronizing the OES Configuration Information before Starting an Upgrade,”
on page 33

Securing Current Data

Before upgrading, secure the current data on the server. For example, make a backup copy of the
data so that you can restore the data volumes later if needed.

Save your configuration files. Copy all configuration files to a separate medium, such as a removable
hard disk or USB stick, to secure the data. This primarily applies to files stored in /etc as well as
some of the directories and files in /var and /opt. You might also want to write the user data in /
home (the Home directories) to a backup medium. Back up this data as root. Only root has read
permission for all local files.
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Ensuring That There Is Adequate Storage Space on the Root
Partition

Before starting your upgrade, make note of the root partition and space available.

If you suspect you are running short of disk space, secure your data before updating and repartition
your system. There is no general rule regarding how much space each partition should have. Space
requirements depend on your particular partitioning profile and the software selected.

The df -h command lists the device name of the root partition. In the following example, the root
partition to write down is /dev/sda2 (mounted as /) with 5.8 GB available.

hlrd:/media # df -h

Filesystem Jize Used Avail Usei: Mounted on
Jdev/sdaz 9.9 3.7z 5.8¢ 39% [

devtmpfs= S40M 124K 940M 1% fdew

tmpfs o40M 244K S940M 1% fdewv/=hm
admin 4.0HM o 4.0M 0% .f’_al:i.min

Preparing the Server You Are Upgrading

Ensure that the server meets the hardware requirements for OES. See Server Hardware in the OES
2018 SP3: Installation Guide.

[tanium is not a supported platform for OES.

Complete the steps in Table 5-2 for your target server.

Table 5-2 Preparing the Server You Are Upgrading

If the Server Is Do This Before Upgrading the Server
Running
OES 2015 SP1 1. Run YaST > Software > Online Update to patch the OES source server to the
latest patch level.
OES 2018
2. Ensure that the server and services are still running as desired.
OES 2018 SP1 . . . S .
3. Upgrade to OES 2018 SP3 using the instructions in this section, then apply all
OES 2018 SP2 patches and verify services.

Checking the Server’s DNS Name

Ensure that DNS returns the correct static IP address when you ping the server's full DNS name. For
example,

ping myserver.example.com

Upgrading to OES 31


https://www.microfocus.com/documentation/open-enterprise-server/2018-SP3/pdfdoc/inst_oes_lx/inst_oes_lx.pdf#Front
https://www.microfocus.com/documentation/open-enterprise-server/2018-SP3/pdfdoc/inst_oes_lx/inst_oes_lx.pdf#Front
https://www.microfocus.com/documentation/open-enterprise-server/2018-SP3/pdfdoc/inst_oes_lx/inst_oes_lx.pdf#bse3r4e

5.3.5

5.3.6

32

Ensuring That the Server Has a Server Certificate

IMPORTANT: Most OES servers have either an eDirectory certificate or a third-party certificate
installed.

These instructions only apply when that is not the case.

Ensure that the server has a server certificate that has been generated and exported as a Common
Server certificate.

To check for or add a certificate:

1
2
3

Launch YaST.

Click Security and Users > CA Management.

If no certificate authorities (CAs) are listed, create one by clicking Create Root CA.
If a CAis listed, you can use it by selecting the CA and clicking Enter CA.

If you are using a listed CA, you must provide the CA password (generally the root password).

5 Click Certificates > Add.

Fill out the forms required for a server certificate. After the last form is complete, a server
certificate is created and listed in the certificate list.

Select the certificate you just created.

Click the Export button, then select Export as Common Server Certificate.

Changing the Mount Options Before an Upgrade

Before starting the upgrade, ensure that the mount options for all the partitions are set to UUID.

If the mount options are incorrect, use the following procedure to select the applicable one:

1
2
3
4

Log on to the OES server with root privileges.
In the terminal, type yast2 disk.
In the Warning dialog box, click Yes

In the Expert Partitioner window, select a partition, such as root(/), then click Edit > Fstab
Options.

Under Fstab options:, click UUID > OK > Finish.

IMPORTANT: If you plan to clone your hard disks in the future, do not select Device ID root as
mount option. The cloning process will fail. For more information, see “New default in SLES/
SLED 10 SP1: mount "by Device ID”.

Repeat Step 4andStep 5 on page 32 or all the Linux partitions (not for NSS partitions).

7 After you have changed the mount options, click Next.

8

In the Expert Petitioner: Summary dialog box, click Finish.

The mount options are successfully changed.
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5.3.7

5.3.8

Preparing an Installation Source

Review and complete the instructions for Setting Up a Network Installation Source in the OES 2018
SP3: Installation Guide. We recommend using the network installation option, especially if you are
upgrading multiple servers.

Synchronizing the OES Configuration Information before Starting
an Upgrade

The modifications that you make to an OES server using YaST are stored in the configuration files at /
etc/syconfig/novell. These crucial configuration information is used to upgrade an OES server.

You can also modify an OES server outside of YaST, and those changes are stored as part of the
respective service configuration files. In this scenario, if you upgrade the OES server, your latest
changes will not be part of the upgrade or the upgrade might fail. This happens because your latest
changes are not captured as part of the configuration information at /etc/syconfig/novell.

To synchronize the latest changes that you have done outside of YaST with the configuration files at /
etc/syconfig/novell, use the upgrade check script (/opt/novell/oes-install/util/
oes_upgrade check.pl) that is available beginning with OES 2015 or you can download the
script from the OES 2018 SP3 documentation site. This script assumes that the respective OES
service configuration file information is the latest and updates it with the configuration information
at /etc/syconfig/novell.

For example, if you have modified LUM outside of YaST, LUM configuration information is stored in
the LUM configuration file at /etc/nam. conf. When you run the oes_upgrade check.pl script,
the upgrade script compares the LUM configuration information at /etc/syconfig/novell
against /etc/nam. conf. If there is a mismatch, the LUM configuration information from /etc/
nam. conf is synchronized with /etc/syconfig/novell.

Syntax: . /oes upgrade check.pl <all | OES service name>

OES service names include afp, lum, edir, cifs, iprint, dhcp, ncs, netstorage,
nss, and dsfw.

Examples:

+ To synchronize all the individual OES service configuration information with /etc/syconfig/
novell, execute the . /oes upgrade check.pl all command.

+ To synchronize any particular OES service configuration information, for example LUM, with /
etc/syconfig/novell, execute the . /oes upgrade check.pl lumcommand.
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6.1

6.2

Migrating Existing Servers and Data

This section briefly outlines the following migration topics:

+ Section 6.1, “Supported OES Migration Paths,” on page 35

+ Section 6.2, “Migration Tools and Purposes,” on page 35

Supported OES Migration Paths

For a complete list of Open Enterprise Server migration scenarios and paths, see “Migration
Scenarios” in the OES 2018 SP3: Migration Tool Administration Guide.

Migration Tools and Purposes

The OES Migration Tool lets you migrate and/or consolidate data and services from one or more
NetWare and OES source servers to an OES 2018 SP3 target server. See “Source Platform Support for
OES 2018 SP3 Services ” in the OES 2018 SP3: Migration Tool Administration Guide.

You can also transfer a complete server identity, including its IP address, hostname, eDirectory
identity, NICI keys, and certificates. For more information, see “Transfer ID ” in the OES 2018 SP3:
Migration Tool Administration Guide.
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1.1

Virtualization in OES

Open Enterprise Server runs as a VM guest on any virtual machine host server that is certified for
running SUSE Linux Enterprise Server 12 SP5 (SLES 12 SP5) as a paravirtualized guest. Because Xen
and KVM are distributed with SLES, they are mentioned more particularly in the OES documentation.

For a list of the VM host platforms that are certified for SLES, see “Supported VM Host Servers for
SLES VM Guests” (https://documentation.suse.com/sles/12-SP5/html/SLES-all/cha-virt-
support.html#tvirt-support-hosts) in the SLES Virtualization Guide (https://documentation.suse.com/
sles/12-SP5/html/SLES-all/book-virt.html).

For information about installing and running OES services on virtual machines, see OES 2018 SP3:
Installation Guide.

+ Section 7.1, “Graphical Overview of Virtualization in OES,” on page 37

+ Section 7.2, “Why Install OES Services on Your VM Host?,” on page 38

+ Section 7.3, “Services Supported on VM Hosts and Guests,” on page 39

¢ Section 7.4, “Xen VMs Need Ext2 for the System /Boot Volume,” on page 40

Graphical Overview of Virtualization in OES

Figure 7-1 illustrates how a single VM host server can support multiple VM guest servers that in turn
provide OES services.

Virtualization in OES 37


https://documentation.suse.com/sles/12-SP5/html/SLES-all/cha-virt-support.html#virt-support-hosts
https://documentation.suse.com/sles/12-SP5/html/SLES-all/cha-virt-support.html#virt-support-hosts
https://documentation.suse.com/sles/12-SP5/html/SLES-all/book-virt.html
https://www.microfocus.com/documentation/open-enterprise-server/2018-SP3/pdfdoc/inst_oes_lx/inst_oes_lx.pdf#Front
https://www.microfocus.com/documentation/open-enterprise-server/2018-SP3/pdfdoc/inst_oes_lx/inst_oes_lx.pdf#Front
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7.2 Why Install OES Services on Your VM Host?

Micro Focus supports four OES services running on a Xen VM host server: Linux User Management,
Storage Management Services, Cluster Services, and iPrint.

Having these components installed on a Xen VM host server provides the following benefits:

+ Linux User Management (LUM): Lets you SSH into the server for management purposes by
using an eDirectory user account.
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1.3

This functionality requires that you
+ Enable SSH communications through any firewalls that are running on the server

+ Configure LUM to allow SSH as a LUM-enabled service. For more information see
“Section 9.4.2, “Setting Up SSH Access for LUM-enabled eDirectory Users,” on page 76.”

+ Storage Management Services (SMS): Lets you back up VM host server file system data.
+ Cluster Services (NCS): Lets you cluster the VM host.

+ Micro Focus iPrint: Lets you print from the host.

Services Supported on VM Hosts and Guests

As you plan your virtualization configurations, you will want to consider which services are
supported where Table 7-1 and which combinations of services are supported.

Table 7-1 Services Supported on VM Hosts and Guests

OES Service Linux VM Host OES VM Guest

AFP (OES AFP)
Backup/SMS '/
CIFS (OES CIFS)

Cluster Services '/ (non-NSS and Xen

templates only)

DHCP
DNS

Domain Services for
Windows (DSfW)

eDirectory

FTP

iManager

iPrint '/’
Linux User Management '/

NCP Server/Dynamic
Storage Technology

SN N N N N N N N N N N NI

NetStorage
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1.4

OES Service Linux VM Host OES VM Guest

OES Remote Manager '/
(NRM)
Storage Services (NSS) '/

IMPORTANT: Adding OES services to a Xen VM host requires that you boot the server with the
regular kernel prior to adding the services. See the instructions in the Important note in “Adding/
Configuring OES Services on an Existing Server” in the OES 2018 SP3: Installation Guide.

Xen VMs Need Ext2 for the System /Boot Volume

It is recommended that operating systems running in paravirtual mode set up their kernel on a
separate partition that uses a non-journaling file system, such as ext2.

Before a paravirtualized operating system can boot, the management domain must construct a
virtual machine and place the paravirtualized kernel in it. Then, the paravirtualized operating system
boots. To retrieve the kernel during the bootstrapping process, the virtual machine’s boot disk is
mounted in read-only mode, the kernel is copied to the virtual machine’s memory, and then the
boot disk is unmounted.

When a virtual machine’s operating system crashes, its disks are not shut down in an orderly
manner. This should not pose a problem to a virtual machine running in full virtualization mode
because the pending disk entries are checked and corrected the next time the operating system
starts. If the disk is using a journaling file system, the journal is replayed to update and coordinate
any pending disk entries.

This type of system crash poses a potential problem for paravirtualized operating systems. If a
paravirtualized operating system using a journaled file system crashes, any pending disk entries
cannot be updated and coordinated because the file system is initially mounted in read-only mode.

Therefore, it is recommended that you set virtual machine boot files, such as the kernel and ramdisk,
on a separate partition that is formatted with a non-journaling file system, such as ext2.
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8.1

8.1.1

Clustering and High Availability

Open Enterprise Server includes support for a two-node OES Cluster Services cluster.

The full OES Cluster Services product (available through a separate purchase) is a multinode
clustering product that

¢ Caninclude up to 32 servers.

+ Is eDirectory enabled for single-point ease of management.

+ Supports failover, failback, and migration (load balancing) of individually managed cluster
resources.

+ Supports shared SCSI, iSCSI, and Fibre Channel storage area networks.

For more information, see the OES 2018 SP3: OES Cluster Services for Linux Administration Guide.

Planning for a Cluster

The success of your high-availability cluster solution depends on its stability and robustness. Use the
guidelines in this section to design your OES Cluster Services cluster and cluster environment.

IMPORTANT: For information about the system requirements for installing and using OES Cluster
Services, see Chapter 8, “Clustering and High Availability,” on page 41.

+ Section 8.1.1, “Determining Your Design Criteria,” on page 41

+ Section 8.1.2, “Using Cluster Best Practices,” on page 42

+ Section 8.1.3, “Planning the LAN Connectivity,” on page 42

+ Section 8.1.4, “Planning the Shared Storage Connectivity,” on page 44

+ Section 8.1.5, “Planning the Shared Storage Solution,” on page 44

+ Section 8.1.6, “Planning the eDirectory Deployment,” on page 44

+ Section 8.1.7, “Planning for Shared Storage as Cluster Resources,” on page 45

+ Section 8.1.8, “Planning for OES Services as Cluster Resources,” on page 46

Determining Your Design Criteria

The purpose of designing a resilient cluster is to ensure that your essential data and services are
highly available. Setting up data and services as cluster resources allows them to be moved between
nodes in the same cluster. This helps eliminate or minimize the downtime caused by a server failure
or maintenance.

You can determine what data and services to set up as cluster resources by asking and answering the
following questions:

O What are the key services that drive your business?

Clustering and High Availability 41


https://www.microfocus.com/documentation/open-enterprise-server/2018-SP3/pdfdoc/clus_admin_lx/clus_admin_lx.pdf#bookinfo

8.1.2

42

8.13

aa

a
a

What services are essential for business continuance?
What is the cost of downtime for the essential services?

Based on their mission-critical nature and cost of downtime, what services are the highest
priority for business continuance?

What data is necessary to support the highest-priority services?

How much data is involved, and how important is it?

Using Cluster Best Practices

Using the following cluster best practices can help you avoid potential problems with your cluster:

*

*

Ensure that eDirectory is stable before implementing a cluster.

Ensure that you have full Read/Write replicas of the entire eDirectory tree co-located in the
data center where you are setting up the cluster.

Ensure that IP addresses are unique.
Consistently apply IP address assignments for each cluster and its cluster resources.

Make IP address changes for the cluster and cluster resources only by using the procedure
described in Moving a Cluster or Changing IP Addresses of Cluster Nodes and Resources in the
OES 2018 SP3: OES Cluster Services for Linux Administration Guide

IP address changes for cluster resources should always be made on the Protocols page of the
iManager Clusters plug-in, not directly in load, unload, and monitor scripts. This is the only way
to change the IP address on the virtual NCS:NCP Server object in eDirectory.

Ensure that Volume IDs used for a cluster resources are unique across all nodes.

Each cluster node automatically assigns volume ID 0 to volume SYS and volume ID 1 to volume
_ ADMIN. Cluster-enabled volumes use high volume IDs, starting from 254 in descending order.

Volume IDs can be assigned in the cluster load script. You can view the volume IDs assigned on a
node by using the ncpcon volumes command.

The Client for Open Enterprise Server uses the volume ID to access a volume.
Consider each node’s configuration requirements for each of the services it is intended to host.

Create failover matrixes for each cluster resource so that you know what service is supported
and which nodes are the preferred nodes for failover.

Planning the LAN Connectivity

The primary objective of LAN connectivity in a cluster is to provide uninterrupted heartbeat
communications. Use the guidelines in this section to design the LAN connectivity for the cluster:

*

*

*

*

“VLAN” on page 43

“Channel Bonding” on page 43
“Spanning Tree Protocol” on page 43
“IP Addresses” on page 43

“Name Resolution” on page 43
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VLAN

Use a dedicated VLAN (virtual local area network) for each cluster.

The cluster protocol is non-routable, so you cannot direct communications to specific IP addresses.
Using a VLAN for the cluster nodes provides a protected environment for the heartbeat process and
ensures that heartbeat packets are exchanged only between the nodes of a given cluster.

When you use a VLAN, no foreign host can interfere with the heartbeat. For example, using a VLAN
avoids broadcast storms that slow traffic and can result in false split-brain situations.

Channel Bonding

Servers should be redundantly cabled to the network in order to provide LAN fault tolerance,
preferably at both the adapter level and the link level. Consider connecting cluster nodes to
redundant access switches for fault tolerance.

Use channel bonding for the server adapters. Channel bonding combines Ethernet interfaces on a
host computer for redundancy or increased throughput. Higher-level software uses a single virtual-
network interface, and the channel bonding driver handles the complex choice of which physical-
network interface to use. Channel bonding helps increase the availability of an individual cluster
node, which helps avoid or reduce the occurrences of failover caused by slow LAN traffic. See the /
usr/src/linux/Documentation/bonding.txt document.

Spanning Tree Protocol

Use the Spanning Tree Protocol (STP) to eliminate network topology loops. When you configure STP,
ensure that the Portfast Bridge Protocol Data Unit (BPDU) guard feature is enabled, or consider using
Rapid Spanning Tree Protocol (RSTP, IEEE 802.11w).

The default settings for STP inhibit the heartbeat for over 30 seconds whenever there is a change in
link status. Test your STP configuration with Cluster Services running to ensure that a node is not cast
out of the cluster when a broken link is restored.

IP Addresses

Plan your IP address assignment so that it is consistently applied across each cluster. For each cluster,
provide a dedicated IP address range with sufficient addresses for the cluster. The addresses do not
need to be contiguous.

You need a unique static IP address for each of the following components of a cluster:

+ Cluster (master IP address)
¢ Cluster nodes

+ Cluster resources (file system resources and service resources such as DHCP, DNS, SLP, FTP, and
so on)

Name Resolution

Ensure that SLP is properly configured for name resolution. See Section 10.5, “SLP,” on page 95.
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8.1.4 Planning the Shared Storage Connectivity

The primary objective of the shared storage connectivity in a cluster is to provide solid and stable
connectivity between cluster nodes and the storage system. Before installing OES Cluster Services
and setting up a cluster, ensure that the storage configuration is established and verified.

Use the guidelines in this section to design the storage connectivity for a cluster:

+ Use host-based multipath I/0 management. See the following resources:
+ Section 8.2.10, “Multipath 1/0 Configuration Requirements,” on page 67

+ “Managing Multipath I/O for Devices” (https://documentation.suse.com/sles/12-SP5/html/
SLES-all/cha-multipath.html) in the SLES Storage Administration Guide (https://
documentation.suse.com/sles/12-SP5/html/SLES-all/stor-admin.html)

+ Connect each node via two fabrics to the storage area network (SAN).

+ Use redundant SAN connections to provide fault-tolerant connectivity between the cluster
nodes and the shared storage devices.

+ Use LUN masking to exclusively assign each LUN to one or more host connections. See
Section 8.2.9, “SAN Rules for LUN Masking,” on page 67.

8.1.5 Planning the Shared Storage Solution

Use the guidelines in this section to design the shared storage solution for a cluster:
+ For maximum flexibility, you should create only one cluster resource per LUN.
A LUN cannot be concurrently accessed by servers belonging to different clusters. This means
that all resources on a given LUN can be active only in a given cluster at any given time.

+ You should use only one LUN per pool, and only one volume per pool. If you use multiple LUNs
for a given shared NSS pool, all LUNs must fail over together.

It is possible to create multiple pools per LUN or to use multiple LUNs per pool, but these
alternatives are not recommended.

8.1.6 Planning the eDirectory Deployment

Your NetlQ eDirectory solution for each cluster must consider the following configuration elements.
Your approach should be consistent across all clusters.

+ “Object Location” on page 44
¢ “Cluster OU Context” on page 45
¢ “Cluster OU Partitioning and Replication” on page 45

Object Location

Cluster nodes and Cluster objects can exist in any container in the eDirectory tree. The Virtual Server
object for the cluster and the objects for cluster resources are automatically created in the
eDirectory context of the server where the cluster resource is created and cluster-enabled.
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IMPORTANT: You should create cluster resources on the master node of the cluster.

Cluster OU Context

Before you create a new cluster, use iManager to create an OU container for the cluster, and use the
OU container for the Cluster objects and Server objects.

Figure 8-1 Example: Clusterl Container and Its Objects
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Cluster OU Partitioning and Replication

Partition the Cluster OU, replicate it to dedicated eDirectory servers that are holding a replica of the
parent partition, and replicate it to all cluster nodes. This helps prevent resources from being stuck in
an NDS Sync state when a cluster resource’s configuration is modified.

If you do not want to put a replica of eDirectory on the node, you must configure one or multiple
LDAP servers for the node to use. The LDAP servers must have a master replica or a Read/Write
replica of eDirectory. For information about how to modify the LDAP server list that is used by a
cluster, see Changing the Administrator Credentials or LDAP Server IP Addresses for a Cluster in the
OES 2018 SP3: OES Cluster Services for Linux Administration Guide

Planning for Shared Storage as Cluster Resources

OES Cluster Services supports using cluster resources for the following file systems and storage
solutions:

File System or Storage Solution See

Storage Services (NSS) pools Configuring and Managing Cluster Resources for
Shared NSS Pools and Volumes

Linux LVM volume groups and logical volumes Configuring and Managing Cluster Resources for
Shared LVM Volume Groups

Linux POSIX volumes Upgrading and Managing Cluster Resources for Linux
POSIX Volumes with CSM Containers

NCP (NetWare Control Protocol) volumes (NCP shares “Configuring NCP Volumes with OES Cluster Services”
on cluster-enabled Linux POSIX volumes) in the OES 2018 SP3: NCP Server for Linux
Administration Guide

Clustering and High Availability 45


https://www.microfocus.com/documentation/open-enterprise-server/2018-SP3/pdfdoc/clus_admin_lx/clus_admin_lx.pdf#bookinfo
https://www.microfocus.com/documentation/open-enterprise-server/2018-SP3/pdfdoc/file_ncp_lx/file_ncp_lx.pdf#H9izvdye
https://www.microfocus.com/documentation/open-enterprise-server/2018-SP3/pdfdoc/file_ncp_lx/file_ncp_lx.pdf#H9izvdye
https://www.microfocus.com/documentation/open-enterprise-server/2018-SP3/pdfdoc/clus_admin_lx/clus_admin_lx.pdf#bgjnbuv
https://www.microfocus.com/documentation/open-enterprise-server/2018-SP3/pdfdoc/clus_admin_lx/clus_admin_lx.pdf#ncsshvolnss
https://www.microfocus.com/documentation/open-enterprise-server/2018-SP3/pdfdoc/clus_admin_lx/clus_admin_lx.pdf#ncsshvolnss
https://www.microfocus.com/documentation/open-enterprise-server/2018-SP3/pdfdoc/clus_admin_lx/clus_admin_lx.pdf#ncsshvollxlvm
https://www.microfocus.com/documentation/open-enterprise-server/2018-SP3/pdfdoc/clus_admin_lx/clus_admin_lx.pdf#ncsshvollxlvm
https://www.microfocus.com/documentation/open-enterprise-server/2018-SP3/pdfdoc/clus_admin_lx/clus_admin_lx.pdf#ncsshvollx
https://www.microfocus.com/documentation/open-enterprise-server/2018-SP3/pdfdoc/clus_admin_lx/clus_admin_lx.pdf#ncsshvollx
https://www.microfocus.com/documentation/open-enterprise-server/2018-SP3/pdfdoc/file_ncp_lx/file_ncp_lx.pdf#bb8fjmv

46

8.1.8

File System or Storage Solution

See

Dynamic Storage Technology (DST) volumes (NSS
volumes configured in a shadow volume pair)

“Configuring DST Shadow Volume Pairs with OES
Cluster Services” in the OES 2018 SP3: Dynamic
Storage Technology Administration Guide

Planning for OES Services as Cluster Resources

OES Cluster Services supports using cluster resources for the following OES services:

Service

See

Apache Web Server

“Apache HTTP Server” in the OES 2015 SP1: Novell
Cluster Services NetWare to Linux Conversion Guide

Apple Filing Protocol

(OES AFP)

“Configuring AFP with OES Cluster Services for an NSS
File System” in the OES 2018 SP3: OES AFP for Linux
Administration Guide

Certificate Server

(NetlQ eDirectory Server Certificates)

“eDirectory Server Certificates” in the OES 2015 SP1:
Novell Cluster Services NetWare to Linux Conversion
Guide

CIFS “Configuring CIFS with Cluster Services for an NSS File
System” in the OES 2018 SP3: OES CIFS for Linux

(OES CIFS) Administration Guide

DFS VLDB “Clustering Distributed File Services” in the OES 2018

(Distributed File Services Volume Location Database)

SP3: Distributed File Services Administration Guide for
Linux

DHCP Server on a Linux POSIX volume

“Configuring DHCP with OES Cluster Services for the
Linux File System” in the OES 2018 SP3: DNS/DHCP
Services for Linux Administration Guide

DHCP Server on an NSS volume

“Configuring DHCP with OES Cluster Services for the
NSS File System” in the OES 2018 SP3: DNS/DHCP
Services for Linux Administration Guide

DNS Server

“Configuring DNS with OES Cluster Services” in the
OES 2018 SP3: DNS/DHCP Services for Linux
Administration Guide

iPrint

“Configuring iPrint with OES Cluster Services” in the
OES 2018 SP3: iPrint Administration Guide

MysQL

“High Availability and Scalability” in the MySQL 5.x
Reference Manual (http://dev.mysgl.com/doc/
refman/5.5/en/ha-overview.html)

“MySQL” in the OES 2015 SP1: Novell Cluster Services
NetWare to Linux Conversion Guide

NetStorage

“Configuring NetStorage with OES Cluster Services” in
the OES 2018 SP3: NetStorage Administration Guide
for Linux.
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Service See

PureFTPd “Cluster Enabling Pure-FTPd in an OES Environment”
in the OES 2018 SP3: Planning and Implementation
(OES FTP) Guide

8.2 Planning for OES Cluster Services

This section describes the requirements for installing and using Cluster Services on Open Enterprise
Server (OES) servers.

IMPORTANT: For information about designing your cluster and cluster environment, see Chapter 8,
“Clustering and High Availability,” on page 41.

+ Section 8.2.1, “Cluster Administration Requirements,” on page 47

+ Section 8.2.2, “IP Address Requirements,” on page 50

+ Section 8.2.3, “Volume ID Requirements,” on page 50

+ Section 8.2.4, “Hardware Requirements,” on page 51

+ Section 8.2.5, “Virtualization Environments,” on page 51

+ Section 8.2.6, “Software Requirements for Cluster Services,” on page 52

+ Section 8.2.7, “Software Requirements for Cluster Resources,” on page 61
+ Section 8.2.8, “Shared Disk Configuration Requirements,” on page 64

+ Section 8.2.9, “SAN Rules for LUN Masking,” on page 67

+ Section 8.2.10, “Multipath I/O Configuration Requirements,” on page 67

8.2.1 Cluster Administration Requirements

You use different credentials to install and set up the cluster and to manage the cluster. This section
describes the tasks performed and rights needed for those roles.

¢ “Cluster Installation Administrator” on page 47

+ “NCS Proxy User” on page 48

¢ “Cluster Administrator or Administrator-Equivalent User” on page 50

Cluster Installation Administrator

Typically, a tree administrator user installs and sets up the first cluster in a tree, which allows the
schema to be extended. However, the tree administrator can extend the schema separately, and
then set up the necessary permissions for a container administrator to install and configure the
cluster.
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NOTE: If the eDirectory administrator user name or password contains special characters (such as S,
#, and so on), some interfaces in iManager and YaST might not handle the special characters. If you
encounter problems, try escaping each special character by preceding it with a backslash (\) when
you enter credentials.

+ “eDirectory Schema Administrator” on page 48

+ “Container Administrator” on page 48

eDirectory Schema Administrator

A tree administrator user with credentials to do so can extend the eDirectory schema before a
cluster is installed anywhere in a tree. Extending the schema separately allows a container
administrator to install a cluster in a container in that same tree without needing full administrator
rights for the tree.

IMPORTANT: It is not necessary to extend the schema separately if the installer of the first cluster
server in the tree has the eDirectory rights necessary to extend the schema.

Container Administrator

After the schema has been extended, the container administrator (or non-administrator user) needs
the following eDirectory rights to install OES Cluster Services:

+ Attribute Modify rights on the NCP Server object of each node in the cluster.
+ Object Create rights on the container where the NCP Server objects are.

+ Object Create rights where the cluster container will be.

For instructions, see Assigning Install Rights for Container Administrators or Non-Administrator
Users.

NCS Proxy User

During the cluster configuration, you must specify an NCS Proxy User. This is the user name and
password that Cluster Services uses when the cluster management tools exchange information with
eDirectory.

Cluster Services supports the OES Common Proxy User enablement feature of eDirectory. The proxy
user is represented in eDirectory as a User object named

OESCommonProxy <server name>.<context>.|f the OES Common Proxy user is enabled in
eDirectory when you configure a node for the cluster, the default NCS Proxy User is set to use the
server’s OES Common Proxy User. You can alternatively specify the LDAP Admin user or another
administrator user.

The specified NCS Proxy User for the node is automatically assigned as a member in the
<cluster name> MGT GRP.<context> group that resides in the Cluster object container, such
asclusl MGT GRP.ncs.novell. The group accommodates the server-specific NCS Proxy Users
that you assign when you configure each node for the cluster. Members are added to the group as
you configure each node for a cluster. Each member of the group has the necessary rights for
configuring the cluster and cluster resources and for exchanging information with eDirectory.
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For example, Figure 8-2 shows that an OES Common Proxy User has been assigned as the NCS Proxy
User for each node in a four-node cluster. The nodes are named avalon, camelot, excalibur,
and cornwall. The context is novell.

Figure 8-2 Members of the NCS Management Group for a Cluster
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IMPORTANT: You can modify this default administrator user name or password for the user name
assigned as the NCS Proxy User after the install by following the procedure in Moving a Cluster, or
Changing the Node IP Addresses, LDAP Servers, or Administrator Credentials for a Cluster.

Consider the following caveats for the three proxy user options:

+ “OES Common Proxy User” on page 49
+ “LDAP Admin User” on page 50

+ “Another Administrator User” on page 50

OES Common Proxy User

If you specify the OES Common Proxy user for a cluster and later disable the Common Proxy user
feature in eDirectory, the LDAP Admin user is automatically assigned to the

<cluster name> MGT GRP.<context> group, and the OES Common Proxy user is automatically
removed from the group.

If an OES Common Proxy User is renamed, moved, or deleted in eDirectory, eDirectory takes care of
the changes needed to modify the user information in the
<cluster name> MGT GRP.<context> group.

If a cluster node is removed from the tree, the OES Common Proxy User for that server is one of the
cluster objects that needs to be deleted from eDirectory.

For information about enabling or disabling the OES Common Proxy User, see the OES 2018 SP3:
Installation Guide. For caveats and troubleshooting information for the OES Common Proxy user, see
the OES 2018 SP3: Planning and Implementation Guide.
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8.2.2

8.2.3

LDAP Admin User

If you specify the LDAP Admin user as the NCS Proxy User, you typically continue using this identity
while you set up the cluster and cluster resources. After the cluster configuration is completed, you
create another user identity to use for NCS Proxy User, and grant that user sufficient administrator
rights as specified in “Cluster Administrator or Administrator-Equivalent User” on page 50.

Another Administrator User

You can specify an existing user name and password to use for the NCS Proxy User. Cluster Services
adds this user name to the <cluster name> MGT GRP.<context> group.

Cluster Administrator or Administrator-Equivalent User

After the install, you can add other users (such as the tree administrator) as administrator equivalent
accounts for the cluster by configuring the following for the user account:

+ Give the user the Supervisor right to the Server object of each of the servers in the cluster.
+ Linux-enable the user account with Linux User Management (LUM).

+ Make the user a member of a LUM-enabled administrator group that is associated with the
servers in the cluster.

IP Address Requirements

O Each server in the cluster must be configured with a unique static IP address.

O You need additional unique static IP addresses for the cluster and for each cluster resource and
cluster-enabled pool.

O All IP addresses used by the master cluster IP address, its cluster servers, and its cluster
resources must be on the same IP subnet. They do not need to be contiguous addresses.

Volume ID Requirements

A volume ID is a value assigned to represent the volume when it is mounted by NCP Server on an
OES server. The Client for Open Enterprise Server accesses a volume by using its volume ID. Volume
ID values range from 0 to 254. On a single server, volume IDs must be unique for each volume. In a
cluster, volume IDs must be unique across all nodes in the cluster.

Unshared volumes are typically assigned low numbers, starting from 2 in ascending order. Volume
IDs 0 and 1 are reserved. Volume ID 0 is assigned by default to volume SYS. Volume ID 1 is assigned
by default to volume _ADMIN.

Cluster-enabled volumes use high volume IDs, starting from 254 in descending order. When you
cluster-enable a volume, Cluster Services assigns a volume ID in the resource’s load script that is
unique across all nodes in a cluster. You can modify the resource’s load script to change the assigned
volume ID, but you must manually ensure that the new value is unique.

In a Business Continuity Clustering (BCC) cluster, the volume IDs of BCC-enabled clustered volumes
must be unique across all nodes in every peer cluster. However, clustered volumes in different
clusters might have the same volume IDs. Duplicate volume IDs can prevent resources from going
online if the resource is BCC-migrated to a different cluster. When you BCC-enable a volume, you
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8.2.5

must manually edit its load script to ensure that its volume ID is unique across all nodes in every
peer cluster. You can use the ncpcon volumes command on each node in every peer cluster to
identify the volume IDs in use by all mounted volumes. Compare the results for each server to
identify the clustered volumes that have duplicate volume IDs assigned. Modify the load scripts to
manually assign unique volume IDs.

Hardware Requirements

The following hardware requirements for installing Cluster Services represent the minimum
hardware configuration. Additional hardware might be necessary depending on how you intend to
use Cluster Services.

O A minimum of two Linux servers, and not more than 32 servers in a cluster

O At least 512 MB of additional memory on each server in the cluster

O One non-shared device on each server to be used for the operating system

O At least one network card per server in the same IP subnet.

In addition to Ethernet NICs, Cluster Services supports VLAN on NIC bonding in OES 11 SP1 (with
the latest patches applied) or later. No modifications to scripts are required. You can use ethx or
vlanx interfaces in any combination for nodes in a cluster.

In addition, each server must meet the requirements for Open Enterprise Server 2018 SP3. See
“Meeting All Server Software and Hardware Requirements” in the OES 2018 SP3: Installation Guide.

NOTE: Although identical hardware for each cluster server is not required, having servers with the
same or similar processors and memory can reduce differences in performance between cluster
nodes and make it easier to manage your cluster. There are fewer variables to consider when
designing your cluster and failover rules if each cluster node has the same processor and amount of
memory.

If you have a Fibre Channel SAN, the host bus adapters (HBAs) for each cluster node should be
identical and be configured the same way on each node.

Virtualization Environments

Xen and KVM virtualization software is included with SUSE Linux Enterprise Server. Cluster Services
supports using Xen or KVN virtual machine (VM) guest servers as nodes in a cluster. You can install
Cluster Services on the guest server just as you would a physical server. All templates except the Xen
and XenlLive templates can be used on a VM guest server. For examples, see Configuring OES Cluster
Services in a Virtualization Environment.

Cluster Services is supported to run on a host server where it can be used to cluster the virtual
machine configuration files on Linux POSIX file systems. Only the Xen and XenLive templates are
supported for use in the XEN host environment. These virtualization templates are general, and can
be adapted to work for other virtualization environments, such as KVM and VMware. For
information about setting up Xen and XenlLive cluster resources for a virtualization host server, see
Virtual Machines as Cluster Resources.
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8.2.6

Software Requirements for Cluster Services

Ensure that your system meets the following software requirements for installing and managing
Cluster Services:

+ “Open Enterprise Server 2018 SP3” on page 52

¢ “Cluster Services” on page 52

+ “NetlQ eDirectory 9.2.1” on page 52

+ “SLP” on page 56

+ “iManager 3.2.1” on page 58

¢ “Clusters Plug-in for iManager” on page 58

+ “Storage-Related Plug-Ins for iManager” on page 59

+ “SFCB and CIMOM” on page 59

¢ “OES Credential Store (OCS)” on page 60

+ “Web Browser” on page 61

Open Enterprise Server 2018 SP3

Cluster Services for Linux supports Open Enterprise Server 2018 SP3. OES Cluster Services is one of
the OES Services patterns.

We recommend having uniform nodes in the cluster. The same release version of OES must be
installed and running on each node in the cluster.

Mixed-mode clusters with different operating system platforms are supported during rolling cluster
upgrades or conversions for the following scenarios:

Upgrading from See:

OES 2015 SP1 or later Upgrading OES Clusters

NetWare 6.5 SP8 OES 2015 SP1: Novell Cluster Services NetWare to Linux Conversion Guide

Cluster Services

Cluster Services is required for creating and managing clusters and shared resources on your OES
servers. OES Cluster Services is one of the OES Services patterns on OES 2018 SP3.

NetlQ eDirectory 9.2.1

NetlQ eDirectory is required for managing the Cluster object and Cluster Node objects for Cluster
Services. eDirectory must be installed and running in the same tree where you create the cluster.
eDirectory can be installed on any node in the cluster, on a separate server, or in a separate cluster.
You can install an eDirectory master replica or replica in the cluster, but it is not required to do so for
Cluster Services.

For information about using eDirectory, see Net/Q eDirectory Administration Guide.
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IMPORTANT: Because the cluster objects and their settings are stored in eDirectory, eDirectory must
be running and working properly whenever you modify the settings for the cluster or the cluster
resources.

In addition, ensure that your eDirectory configuration meets the following requirements:

+ “eDirectory Tree” on page 53

+ “eDirectory Context” on page 53

¢ “Cluster Object Container” on page 54

¢ “Cluster Objects Stored in eDirectory” on page 55

+ “LDAP Server List” on page 56

eDirectory Tree

All servers in the cluster must be in the same eDirectory tree.

eDirectory Context

If you are creating a new cluster, the eDirectory context where the new Cluster object will reside
must be an existing context. Specifying a new context during the Cluster Services configuration does
not create a new context.
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Cluster Object Container

We recommend that the Cluster object and all of its member Server objects and Storage objects be
located in the same OU context. Multiple Cluster objects can co-exist in the same eDirectory
container. In iManager, use Directory Administration > Create Object to create a container for the
cluster before you configure the cluster.

For example, Figure 8-3 shows an example where all clusters are configured in the ncs
organizational unit. Within the container, each cluster is in its own organizational unit, and the
Server objects for the nodes are in the same container as the Cluster object:

Figure 8-3 Same Container for Cluster Object and Server Objects
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If the servers in the cluster are in separate eDirectory containers, the user that administers the
cluster must have rights to the cluster server containers and to the containers where any cluster-
enabled pool objects are stored. You can do this by adding trustee assignments for the cluster
administrator to a parent container of the containers where the cluster server objects reside. For
more information, see “eDirectory Rights” in the Net/Q eDirectory Administration Guide.

Renaming a pool involves changing information in the Pool object in eDirectory. If Server objects for
the cluster nodes are in different containers, you must ensure that the shared pool is active on a

cluster node that has its NCP server object in the same context as the Pool object of the pool you are
going to rename. For information about renaming a shared pool, see Renaming a Clustered NSS Pool
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Cluster Objects Stored in eDirectory

Table 8-1 shows the cluster objects that are automatically created and stored in eDirectory under the

Cluster object (&') after you create a cluster:

Table 8-1 Cluster Objects

Icon eDirectory Object
& Master_IP_Address_Resource
Q Cluster Node object (servername)
‘\3 Resource Template objects. There are 11 default templates:
AV_Template

DHCP_Template
DNS_Template
Generic_FS_Template
Generic_IP_Service
iPrint_Template
MySQL_Template
Samba_Template
Xen_Template
XenLive_Template

For example, Figure 8-4 shows the 13 default eDirectory objects that are created in the Cluster

container as viewed from the Tree view in iManager:

Figure 8-4 Tree View of the Default eDirectory Objects in the Cluster
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Table 8-2 shows the cluster objects that are added to eDirectory when you add nodes or create
cluster resources:

Table 8-2 Cluster Resource Objects

Icon eDirectory Object

@ Cluster Node object (servername)

@, NSS Pool Resource object (poolname_SERVER)
[ Resource object

Table 8-3 shows the cluster objects that are added to eDirectory when you add nodes or create
cluster resources in a Business Continuity Cluster, which is made up of OES Cluster Services clusters:

Table 8-3 BCC Cluster Resource Objects

Icon eDirectory Object

&% BCC NSS Pool Resource object
Qﬁ BCC Resource Template object
N BCC Resource object

LDAP Server List

If eDirectory is not installed on a node, it looks to the LDAP server list for information about which
LDAP server to use. As a best practice, you should list the LDAP servers in the following order:

+ Local to the cluster

+ Closest physical read/write replica

For information about configuring a list of LDAP servers for the cluster, see Changing the
Administrator Credentials or LDAP Server IP Addresses for a Cluster.

SLP

SLP (Service Location Protocol) is a required component for Cluster Services on Linux when you are
using NCP to access file systems on cluster resources. NCP requires SLP for the ncpcon bind and
ncpcon unbind commands in the cluster load and unload scripts. For example, NCP is needed for
NSS volumes and for NCP volumes on Linux POSIX file systems.

SLP is not automatically installed when you select Cluster Services. SLP is installed as part of the
eDirectory configuration during the OES installation. You can enable and configure SLP on the
eDirectory Configuration - NTP & SLP page. For information, see “Specifying SLP Configuration
Options” in the OES 2018 SP3: Installation Guide.
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When the SLP daemon (s1pd) is not installed and running on a cluster node, any cluster resource
that contains the ncpcon bind command goes comatose when it is migrated or failed over to the
node because the bind cannot be executed without SLP.

The SLP daemon (s1pd) must also be installed and running on all nodes in the cluster when you
manage the cluster or cluster resources.

NCP Server re-registers cluster resource virtual NCP servers with SLP based on the setting for the
eDirectory advertise-life-time (n4u.nds.advertise-1ife-time) parameter. The parameter is set
by default to 3600 seconds (1 hour) and has a valid range of 1 to 65535 seconds.

You can use the ndsconfig set command to set the ndu.nds.advertise-life-time
parameter. To reset the parameter in a cluster, perform the following tasks on each node of the
cluster:

1 Login to the node as the root user, then open a terminal console.

2 Take offline all of the cluster resources on the node, or cluster migrate them to a different
server. At a command prompt, enter

cluster offline <resource name>
or

cluster migrate <resource name> <target node name>

3 Modify the eDirectory SLP advertising timer parameter (n4u.nds.advertise-life-time),
then restart ndsd and slpd. At a command prompt, enter

ndsconfig set ndu.nds.advertise-life-time=<value in seconds>
rcndsd restart

rcslpd restart

4 Bring online all of the cluster resources on the node, or cluster migrate the previously migrated
resources back to this node.

cluster online <resource name>
or

cluster migrate <resource name> <node name>
5 Repeat the previous steps on the other nodes in the cluster.

OpenSLP stores the registration information in cache. You can configure the SLP Directory Agents to
preserve a copy of the database when the SLP daemon (s1pd) is stopped or restarted. This allows
SLP to know about registrations immediately when it starts.

For more information about configuring and managing SLP, see “Configuring OpenSLP for
eDirectory” in the NetlQ eDirectory Administration Guide.
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iManager 3.2.1

iManager is required for configuring and managing clusters on OES.

iManager must be installed on at least one computer in the same tree as the cluster. It can be
installed in the cluster or not in the cluster. For information about using iManager, see the iManager
documentation website (https://www.netig.com/documentation/imanager-32/).

For SFCB (Small Footprint CIM Broker) and CIMOM requirements, see “SFCB and CIMOM” on
page 59.

For browser configuration requirements, see “Web Browser” on page 61.

Clusters Plug-in for iManager

The Clusters plug-in for iManager provides the Clusters role where you can manage clusters and
cluster resources with OES Cluster Services. The plug-in can be used on all operating systems
supported by iManager and iManager Workstation.

The following components must be installed in iManager:

¢ Clusters (ncsmgmt . rpm)
+ Common code for storage-related plug-ins (storagemgmt . rpm)

See “Storage-Related Plug-Ins for iManager” on page 59.

If iManager is also installed on the server, these files are automatically installed in iManager when
you install OES Cluster Services.

The Clusters plug-in also provides an integrated management interface for OES Business Continuity
Clustering (BCC). The additional interface is present only if BCC is installed on the server. See the
following table for information about the versions of BCC that are supported. BCC is sold separately
from OES. For purchasing information, see the BCC product page (http://www.novell.com/products/
businesscontinuity/).

BCC Release OES Support iManager and Clusters Plug-In

BCC2.6 OES 2018 SP1 and later  NetlQ iManager 3.1 or later

Requires the Clusters plug-in for OES 2018 SP3 with the
latest patches applied.

See the BCC 2.6 Administration Guide (https://
www.microfocus.com/documentation/open-enterprise-
server/2018-SP3/bcc26_0es2018sp3_admin_Ix/
bookinfo.html).
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Storage-Related Plug-Ins for iManager

In OES 11 and later, the following storage-related plug-ins for iManager share code in common in the
storagemgmt . rpm file:

Product Plug-In NPM File

Novell Apple Filing Protocol (AFP) File Protocols > AFP afpmgmt . rpm
Novell CIFS File Protocols > CIFS cifsmgmt.rpm
Novell Cluster Services Clusters ncsmgmt . rpm
Novell Distributed File Services Distributed File Services dfsmgmt . rpm
Novell Storage Services Storage nssmgmt . rpm

These additional plug-ins are needed when working with the NSS file system. Ensure that you
include the common storagemgmt . rpm plug-in module when installing any of these storage-
related plug-ins.

IMPORTANT: If you use more than one of these plug-ins, you should install, update, or remove them
all at the same time to ensure that the common code works for all plug-ins.

Ensure that you uninstall the old version of the plug-ins before you attempt to install the new
versions of the plug-in files.

The plug-in files are included on the installation disk. The latest storage-related plug-ins can be
downloaded as a single zipped download file from the Micro Focus Downloads website (http://
download.novell.com). For information about installing plug-ins in iManager, see “Downloading and
Installing Plug-in Modules” in the NetlQ iManager Administration Guide.

For information about working with storage-related plug-ins for iManager, see “Understanding
Storage-Related Plug-Ins” in the OES 2018 SP3: NSS File System Administration Guide for Linux.

SFCB and CIMOM

The Small Footprint CIM Broker (SFCB) replaces OpenWBEM for CIMOM activities in OES 11 and
later. SFCB provides the default CIMOM and CIM clients. When you install any OES components that
depend on WBEM, SFCB and all of its corresponding packages are installed with the components. For
more information, see “Appendix N, “Small Footprint CIM Broker (SFCB),” on page 297".

IMPORTANT: SFCB must be running and working properly whenever you modify the settings for the
cluster or the cluster resources.

Port 5989 is the default setting for Secure HTTP (HTTPS) communications. If you are using a firewall,
the port must be opened for CIMOM communications. Ensure that the CIMOM broker daemon is
listening on port 5989. Log in as the root user on the cluster master node, open a terminal console,
then enter the following at the command prompt:

netstat -an |grep -i5989
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The Clusters plug-in (and all other storage-related plug-ins) for iManager require CIMOM
connections for tasks that transmit sensitive information (such as a user name and password)
between iManager and the admin volume on the OES server that you are managing. Typically,
CIMOM is running, so this should be the normal condition when using the server. CIMOM
connections use Secure HTTP (HTTPS) for transferring data, and this ensures that sensitive data is
not exposed.

IMPORTANT: SFCB is automatically PAM-enabled for Linux User Management (LUM) as part of the
OES installation. Users not enabled for LUM cannot use the CIM providers to manage OES. The user
name that you use to log in to iManager when you manage a cluster and the BCC cluster must be an
eDirectory user name that has been LUM-enabled.

For more information about the permissions and rights needed by the administrator user, see
Section 8.2.1, “Cluster Administration Requirements,” on page 47.

IMPORTANT: If you receive file protocol errors, it might be because SFCB is not running.

You can use the following commands to start, stop, or restart SFCB:

To perform this task At a command prompt, enter as the root user

To start SFCB rcsfcb startorsystemctl start sblim-
sfcb.service

To stop SFCB rcsfcb stoporsystemctl stop sblim-
sfcb.service

To check SFCB status rcsfcb status orsystemctl status
sblim-sfcb.service

To restart SFCB rcsfcb restart orsystemctl restart
sblim-sfcb.service

For more information, see “Web Based Enterprise Management using SFCB” (https://
documentation.suse.com/sles/12-SP5/html/SLES-all/cha-wbem.html) in the SUSE Linux Enterprise
Server 12 Administration Guide (https://documentation.suse.com/sles/12-SP5/html/SLES-all/book-
sle-admin.html).

OES Credential Store (OCS)

Cluster Services requires OES Credential Store to be installed and running on each node in the
cluster.

To check whether the OCS is running properly, do the following:

1. At the command prompt, enter as the root user.
2. Run the following command:

oescredstore -1
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8.2.7

Web Browser

For information about supported web browsers for iManager, see “System Requirements for
iManager Server” in the NetlQ iManager Installation Guide.

The Clusters plug-in for iManager might not operate properly if the highest priority Language setting
for your web browser is set to a language other than one of the supported languages in iManager. To
view a list of supported languages and codes in iManager, select the Preferences tab, click Language.
The language codes are Unicode (UTF-8) compliant.

To avoid display problems, in your web browser, select Tools > Options > Languages, and then set the
first language preference in the list to a supported language. You must also ensure the Character
Encoding setting for the browser is set to Unicode (UTF-8) or ISO 8859-1 (Western, Western
European, West European).

+ In a Mozilla browser, select View > Character Encoding, then select the supported character
encoding setting.

+ In an Internet Explorer browser, select View > Encoding, then select the supported character
encoding setting.

Software Requirements for Cluster Resources

Ensure that your system meets the following software requirements for creating and managing
storage cluster resources:

+ “NCP Server for Linux” on page 61

+ “Storage Services File System for Linux” on page 62

+ “LVM Volume Groups and Linux POSIX File Systems” on page 63

+ “NCP Volumes on Linux POSIX File Systems” on page 63

+ “Dynamic Storage Technology Shadow Volume Pairs” on page 63

+ “NCP File Access” on page 63

+ “AFP” on page 63

+ “CIFS” on page 64

+ “Domain Services for Windows” on page 64

NCP Server for Linux

NCP Server for Linux is required in order to create virtual server names (NCS:NCP Server objects)
for cluster resources. This includes storage and service cluster resources. To install NCP Server, select
the NCP Server and Dynamic Storage Technology option during the install.

NCP Server for Linux also allows you to provide authenticated access to data by using the OES
Trustee model. The NCP Server component must be installed and running before you can cluster-
enable the following storage resources:

+ NSS pools and volumes

+ NCP volumes on Linux POSIX file systems
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+ Dynamic Storage Technology shadow volume composed of a pair of NSS volumes

+ Linux Logical Volume Manager volume groups that use an NCS:NCP Server object, such as
those created by using the Logical Volume Manger (NLVM) commands or the NSS Management
Utility (NSSMU)

WARNING: Cross-protocol file locking is required when using multiple protocols for data access on
the same volume. This helps prevent possible data corruption that might occur from cross-protocol
access to files. The NCP Cross-Protocol File Lock parameter is enabled by default when you install
NCP Server. If you modify the Cross-Protocol File Lock parameter, you must modify the setting on all
nodes in the cluster.

NCP Server does not support cross-protocol locks across a cluster migration or failover of the
resource. If a file is opened with multiple protocols when the migration or failover begins, the file
should be closed and reopened after the migration or failover to acquire cross-protocol locks on the
new node.

See “Configuring Cross-Protocol File Locks for NCP Server” in the OES 2018 SP3: NCP Server for Linux
Administration Guide.

NCP Server for Linux is not required when running Cluster Services on a Xen-based virtual machine
(VM) host server (Dom0) for the purpose of cluster-enabling an LVM volume group that holds the
configuration files for Xen-based VMs. Users do not directly access these VM files.

For information about configuring and managing NCP Server for Linux, see the OES 2018 SP3: NCP
Server for Linux Administration Guide.

For information about creating and cluster-enabling NCP volumes on Linux POSIX file systems, see
“Configuring NCP Volumes with OES Cluster Services” in the OES 2018 SP3: NCP Server for Linux
Administration Guide.

Storage Services File System for Linux

Storage Services (NSS) file system on Linux provides the following capabilities used by OES Cluster
Services:

+ Initializing and sharing devices used for the SBD (split-brain detector) and for shared pools. See
“SBD Partitions” on page 65.

+ Creating and cluster-enabling a shared pool. See Configuring and Managing Cluster Resources
for Shared NSS Pools and Volumes.

+ Creating and cluster-enabling a shared Linux Logical Volume Manager (LVM) volume group. See
Configuring and Managing Cluster Resources for Shared LVM Volume Groups.

The NSS pool configuration and NCS pool cluster resource configuration provide integrated
configuration options for the following advertising protocols:

+ NetWare Core Protocol (NCP), which is selected by default and is mandatory for NSS. See “NCP
Server for Linux” on page 61.
+ OES Apple Filing Protocol (AFP). See “AFP” on page 63.

+ OES CIFS. See “CIFS” on page 64.
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LVM Volume Groups and Linux POSIX File Systems

Cluster Services supports creating shared cluster resources on Linux Logical Volume Manager (LVM)
volume groups. You can configure Linux POSIX file systems on the LVM volume group, such as Ext3,
XFS, and ReiserFS. LVM and Linux POSIX file systems are automatically installed as part of the OES
installation.

After the cluster is configured, you can create LVM volume group cluster resources as described in
Configuring and Managing Cluster Resources for Shared LVM Volume Groups.

NCP Server is required if you want to create a virtual server name (NCS:NCP Server object) for the
cluster resource. You can add an NCP volume (an NCP share) on the Linux POSIX file system to give
users NCP access to the data. See “NCP Server for Linux” on page 61.

NCP Volumes on Linux POSIX File Systems

After you cluster-enable an LVM volume group, Cluster Services supports creating NCP volumes on
the volume group’s Linux POSIX file systems. NCP Server is required. See “NCP Server for Linux” on
page 61.

For information about creating and cluster-enabling NCP volumes, see “Configuring NCP Volumes
with OES Cluster Services” in the OES 2018 SP3: NCP Server for Linux Administration Guide.

Dynamic Storage Technology Shadow Volume Pairs

Cluster Services supports clustering for Dynamic Storage Technology (DST) shadow volume pairs on

OES 11 and later. DST is installed automatically when you install NCP Server for Linux. To use cluster-
enabled DST volume pairs, select the NCP Server and Dynamic Storage Technology option during the

install.

For information about creating and cluster-enabling Dynamic Storage Technology volumes on Linux,
see “Configuring DST Shadow Volume Pairs with OES Cluster Services” in the OES 2018 SP3: Dynamic
Storage Technology Administration Guide.

NCP File Access

Cluster Services requires NCP file access to be enabled for cluster-enabled NSS volumes, NCP
volumes, and DST volumes, even if users do not access files via NCP. This is required to support
access control via the OES Trustee model. See “NCP Server for Linux” on page 61.

AFP

Cluster Services supports using AFP as an advertising protocol for cluster-enabled NSS pools and
volumes.

AFP is not required to be installed when you install OES Cluster Services, but it must be installed and
running before you enable AFP as an advertising protocol for an NSS pool cluster resource.
Otherwise, the resource will be in a comatose state, and cannot be brought online. The AFP daemon
should also be running before you bring resources online that have AFP enabled.
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To install AFP, select the OES AFP option from the OES Services list during the install. For information
about configuring and managing the AFP service, see the OES 2018 SP3: OES AFP for Linux
Administration Guide.

CIFS

Cluster Services supports using CIFS as an advertising protocol for cluster-enabled NSS pools and
